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You told us you wanted a better newsletter, and we listened. Your 
Working Smarter with Microsoft Office is now an 8-page monthly, 
packed with more tips, illustrations, and challenges than ever 
before. We want to make you a power user. Please tell us how 
we’re doing by writing to me at editor@working-smarter.com.

Bigger, Better, Stronger than ever! 

Work faster by customizing 
Excel's default settings  
When you create a workbook, do you typically change its default set-

tings, such as font, number of worksheets, and column width? If so, 
consider changing Excel’s defaults to the ones you want. You can change 
some defaults in the Options dialog box, while you can change others in a 
startup template. (You can change some settings in either place.)

Change defaults
Choose Tools | Options and then click on the General tab. Excel’s original 
default font is Arial, a nice sans serif font. But if you want to always start 
with a different default font, open the Standard Font dropdown menu and 
choose the font you want, as shown in Figure A. While you’re at it, you 
might want to set the Size to something other than the original default 10-
point font size. 

In the Default File Location text box, you can type the complete path to 
your preferred working folder, to which Excel automatically goes when 
you tell it to open or save a file. (If you type a path in the Alternate Startup 
File Location text box, starting Excel will automatically open all workbooks 
in that folder.)

When 
you start 
Excel or 
open a new 
file, the 
open work-
book has 
three blank 
worksheets 
by default. 
To change 
this, click 
on the up Figure A
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T.O.P.S. AWARD
Are you T.O.P.S. (The Office Problem Solver) in your 
office? Surely you’ve encountered many challenges in 
your job. Is there a task or project in Microsoft Office 
that you or a coworker found particularly difficult and 
then successfully solved? We want to hear about it. 

Submit your story and examples of your work, and we’ll choose 
a T.O.P.S. winner based on creativity and resourcefulness. We will 
announce the winner and print their story in a future issue. The winner 
will receive a free 6-month subscription to one of our other publications. 
Check out our titles at http://www.workingsmartertraining.com.

Email your submissions to editor@working-smarter.com with the  
subject line, “The Office Problem Solver.”

QUICK TIPSQUICK TIPSQUICK TIPS

T.O.P.S.

or down arrow on the Set Sheets In New 
Workbook spin box and choose the num-
ber of sheets you want, 1 to 255. Click OK.

Change the startup template
If you often increase a workbook’s col-
umn width, you'll be happy to know that 
Column width is among the defaults you 
can change. You have to create a startup 
template with the changes, name it Book.
xlt, and save it in the Excel startup folder, 
Xlstart. 

To do so, open a new workbook. 
Change any default settings you like. For 
example, increase column width, delete 
or insert worksheets, add a header or 
footer, or insert a boilerplate graphic.
Then choose File | Save As. In the File 
Name text box, type Book, and choose 
Template (*.xlt) 
from the Save As 
Type dropdown 
list, as shown in 
Figure B.  

In the Save In dropdown list, choose 
the Xlstart folder for your system. To find 
it, use the following file location list. (The 
second location in each pair is for sys-
tems using user profiles.)
Windows 98: C:\Program Files\Microsoft 
Office\Office\Xlstart or, C:\Windows\
Application Data\Microsoft\Excel\Xlstart
Windows 2000 or Windows XP:  
C:\Program Files\Microsoft Office\Office\
Xlstart or, C:\Documents and Settings\All 
Users\Application Data\Microsoft\Excel\
XLSTART
Windows NT 4: C:\Program Files\
Microsoft Office\Office\Xlstart or, 
C:\Winnt\Profiles\All Users\Application 
Data\Microsoft\Excel\Xlstart

Click OK. To test your template file, 
exit Excel, then restart Excel. (If you want 

the original 
template 
back, move 
or delete 
Book.xlt from 
Xlstart.) 

Customize Excel's default settings
 (continued from page 1)

PowerPoint: Crop your images 
so your audience knows what to 
focus on

You insert pictures into your slides 
because they help to tell your story visu-
ally. Unfortunately, when most people 
take pictures, they also capture unnec-
essary scenery that can distract your 
audience. To avoid this, crop pictures to 
remove anything in the image that isn’t 
necessary. 

Figure A shows an image you might 
use to demonstrate skilled cake decorat-
ing techniques. You want the audience to 
focus on the hand position, but the excess 
imagery doesn’t direct the eye to the 
hands. In fact, the woman’s face draws 
our attention because most people are 
naturally drawn to faces. To resolve the 
issue, we cropped the image, as shown in 
Figure B.

Figure B

Figure A

Figure B
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QUICK TIPSQUICK TIPSQUICK TIPSNever forget that important email or 
meeting by using Outlook Flags

Do you know at a glance which mes-
sages in your Outlook Inbox you 

need to follow up on? To jog your memo-
ry, consider using Outlook’s flags.

Flags are icons you can display next to 
messages that you want to remind your-
self or the recipient about. For example, 
you might add a Follow Up flag by a 
message that contains the instructions for 
a task you must complete. Or, you can 
add a Call flag to a message that requires 
a follow-up phone call.
• Add a flag.  To add a flag to a mes-
sage, open the message you want to 
mark. (You can also add a flag to a mes-
sage before you send it.) On the email’s 
Standard toolbar, click the Message Flag 
tool. From the Flag To dropdown list, 
choose any of the flags listed, as shown 
in Figure A.

To set a date and time as the deadline 
for the flag action, choose the desired date 
from the Due By dropdown list. Once the 
date is set, you can edit the time next to the 
Due By dropdown list. Click OK. Note the 
info flag above the From field, then close 
the message. Now the message has a red 
flag icon in its Flag column.  
• Reminder alerts. If you set a By date 
and time for a flag, and Outlook is running 
at the set time, a reminder message pops 
up. In the Reminder dialog box, you can 
choose Dismiss, Snooze, or Open Item. 
If you click Snooze, you can choose to be 
reminded again in minutes, hours, days, or 
weeks.
• Cancel a flag.  After completing a 
follow-up action, right-click on the mes-
sage and choose Flag Complete or Clear 
Message Flag. Or, open the message and 

click Message Flag. In the 
the dialog box, choose 
Clear Flag, or select 
Completed and click OK. 
(The message’s flag icon 
turns white.) 

 
Word: Yank all hyperlinks and 
their display text

If you want to remove all of the hyperlinks 
in your document and you aren’t interest-
ed in keeping the associated display text 
for each link, here’s how to do so:

1. Select your entire document, or just 
the text that contains your hyperlinks. 

2. Press [Shift][F9] to reveal the hyper-
link code.

3. Select Edit | Replace from the menu 
bar to open the Find And Replace dialog 
box.

4. Click the More button to expand the 
dialog box.

5. With the insertion point in the Find 
What text box, click Special and select 
Field from the dropdown list, as shown in 
Figure A. This places ^d in the Find What 
text box.

6. Leave the Replace With text box 
empty.

7. Click Find Next, and then click 
Replace to replace the first instance. 

8. Once you’re sure Find And Replace 
is working properly, you can click Replace 
All to change all remaining hyperlinks. 

This procedure leaves no trace of the 
hyperlinks. It removes any other type 
of field as well, if you selected that field 
along with all your hyperlinks.

I don't have to tell you that working 
in Access can be tricky. One aspect 

that might confuse you is the fact that 
there are two types of pop-up forms. 
The first type are forms that stay on top 
of all other forms and objects regard-
less of which object is active. In Form 
view, a modeless pop-up form lets you 
access other objects, but a modal pop-up 
doesn’t. You must respond to a modal 
pop-up form before Access will release it 
and let you continue. 

With your form in Design view, click 
the form selector or the Properties tool 
to open the form’s property sheet, and 
click on the Other tab. To make this a 

modal form, set both the Pop Up and 
Modal properties to Yes. To make it a 
modeless form, set the Pop Up prop-
erty to Yes and the Modal property to 
No. 

Here’s a real power user tip: if you 
use OpenForm to open a modal form, 
you must specify the acDialog constant 
as:

DoCmd.OpenForm  
“formname”, , , , ,acDialog.  

If you omit the acDialog constant, 
Access ignores the Modal property 
setting.  

Figure A

Stop Access confusion! Get the 
lowdown on modal vs. modeless 

Figure A
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A chart is often the best way to con-
dense information and present it so 

audience members quickly grasp your 
message. Creating a chart in PowerPoint 
is often unnecessary for two primary 
reasons: First, more robust charting 
programs, such as Excel, are easier to 
use and have more formatting flexibility. 
Second, there’s no reason to re-create a 
chart that already exists in another pro-
gram. Fortunately, copying and pasting a 
chart from Excel to PowerPoint is simple. 
On the other hand, retaining or updating 
the chart’s formatting in the process can 
be tricky. So, in this article, we’ll take a 
look at several techniques that help you 
integrate an imported chart with your 
slide’s design. We’ll even show you how 
to add new effects to an imported chart, 
as illustrated in Figure A.

Variations on a theme
The first step in getting an Excel chart 
into PowerPoint is to copy it to the 
Clipboard. To do so, launch Excel and 
open the workbook with the chart you 
wish to copy. Select the entire chart, and 
press [Ctrl]C. Now, launch PowerPoint 
and navigate to the slide on which you 
want the chart in Slide or Normal view. 
Press [Ctrl]V to paste the chart. Leave 
the default option, Excel Chart (Entire 

Workbook), selected in the Paste smart 
tag for now.

To resize a chart without distorting the 
text, drag one of its corner editing han-
dles to increase or decrease the chart’s 
size proportionately. To update the 
chart’s colors to match your presenta-
tion’s color scheme, make sure the chart 
is still selected and click the Recolor 
Excel Chart button on the Picture toolbar. 
(If your Picture toolbar isn’t displayed, 
choose View | Toolbars | Picture from 
the menu bar.) Then, select the Entire 
Color Scheme or the Only Text And 
Background Colors option button in the 
resulting Recolor Excel Chart dialog box, 
as shown in Figure B.

Now, PowerPoint updates your chart’s 
colors to match your slide each time you 
change your color scheme. For more 
formatting flexibility, you can double-
click on the chart to open Excel’s tools 
in your PowerPoint environment. Or, 
another attractive formatting option is to 
ungroup your chart. 

Ungrouping for all the right 
reasons
There are many reasons to ungroup a 
pasted chart. First, you can easily correct 
any distortions in text due to application 

incompatibility. Second, you increase 
your formatting and design opportunities 
in a variety of ways.

Warning: You can’t ungroup a chart 
that you’ve linked to an Excel workbook 
because ungrouping breaks the link. 

Fix distorted text by ungrouping
To ungroup a selected chart, choose 
Ungroup from the Draw menu on the 
Drawing toolbar. When a message box 
appears asking if you want to convert the 
imported object to a Microsoft Drawing 
object, click Yes. Repeat this step until the 
Ungroup option is no longer available. 
When you do so, PowerPoint automati-
cally corrects any distorted text and con-
verts it to the nearest font size. As you 
can see in Figure C, however, you often 
still need to edit the size of the text and 
the layout of the text boxes.

Since ungrouping breaks down the 
chart into its individual components, 
you now have more design and edit-
ing flexibility. In fact, all of the effects 
shown in Figure A were made possible 
by ungrouping the chart. (Note that the 
opaque patterns in our sample chart 
are only possible to create and view in 
PowerPoint 2002 and later.) Here’s some 
things you can try to jazz up one of your 
own charts:

• Use the Font 
and Font Size 
dropdown lists 
on the Formatting 
toolbar, and the 
Font Color button 
on the Drawing 
toolbar to custom-
ize the label for a 
charted item you 
want to stand out.

Don't duplicate your work: Insert an already formatted 
Excel chart into your PowerPoint presentation

Figure A Figure B
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• Remove the background component 
of the chart by selecting it and press-
ing [Delete] so your slide design bleeds 
through.

• Use the Line Style button on the 
Drawing toolbar to add thickness to the 
appropriate gridline to illustrate a set 
value or goal.

• Adjust the Transparency slider or 
select the Semitransparent check box 
in the Format AutoShape dialog box to 
make chart components opaque. With 
your AutoShape selected, choose Format 
| AutoShape to access the Format Auto-
Shape dialog box.

• Create a new effect, such as a 
Pattern or Picture fill, for any or all of 
the chart bars (or other components) by 
selecting Fill Effects from the Fill Color 
tool’s dropdown menu.

When your chart looks the way you 
want it to, select all of its pieces and 
choose Group (Regroup in Excel 2003) 
from the Draw menu on the Drawing 
toolbar. Once you’ve put 
your chart back together 
again, you can continue 
with your presentation’s 
design.

Tip: The easiest way 
to make sure all of your 
pieces are selected to 
regroup your chart is to 
press [Ctrl]A.

Paste a picture-
perfect chart
Although converting a 
chart to a Microsoft Drawing object 
can greatly reduce your presentation’s 
file size, another alternative is to paste 
a chart onto your slide as a picture. 
To do so in PowerPoint 2002/2003, 
choose Picture Of Chart (Smaller File 
Size) from the Paste smart tag when 
you paste the chart on your slide, as 
shown in Figure D. If you’re using 
PowerPoint 2000, choose Edit | Paste 

Special, select Picture or Picture (Enhanced 
Metafile) in the Paste Special dialog box, 
and then click OK.

When you’re inserting a chart as a pic-
ture, you can also launch the Recolor Picture 
dialog box by clicking the Recolor Picture 
button, which appears in place of, and looks 
the same as, the Recolor Excel Chart but-
ton on the Picture toolbar. (Note that the 
Recolor Picture dialog box doesn’t offer the 
same amount of recoloring and design flex-
ibility as the ungrouping method.) 

Charts with form and function
Although you can simply copy and paste 
an Excel chart onto a slide, there are many 
ways to tweak and embellish it through-
out the process. If time is an issue, you 
may just want to update the colors to 
match your slide’s color scheme. But with 
a little creativity and a little work, you can 
maintain a chart’s informative function 
while transforming it into an eye-catching 
design element.

If you’re sending a picture in an email 
message, why not make it easier for 
your recipient to view it? Instead of 
adding the picture as an attachment to 
the email message, include it directly 
with the message text. To do so:

1. Click on the Mail icon in the 
Navigation Pane (click on the Inbox 
folder in the Folder List in 2000 and 
2002).

2. Click the New button on the 
Outlook Standard toolbar to launch a 
new Message form.

3. Enter any text you’d like in the 
message area of the Message form.

4. Click in the message area where 
you want the inline picture to appear.

5. Choose Insert | Picture | From 
File from the Message form’s menu 
bar. 

6. Click the Browse button in the 
Picture dialog box and locate the file 
you want to include. Then, click Open 
and OK (click Insert in 2000 and 2002). 

7. Resize the picture if needed by 
dragging the sizing handles.

8. Send the message as you nor-
mally would.

When the recipient opens the email 
message, she can already see the pic-
ture without having to open an attach-
ment, as shown in Figure A. The 
picture will even show in the Reading 
Pane (Preview Pane in 2000 and 2002) 
without opening the message.

Outlook: Insert a picture for 
easier viewing 

Figure A

Figure C

Figure D



Working Smarter with Microsoft Office                    Call 1-800-424-8668 to subscribe6

Q I created an Outlook folder for email 
messages, but I want to change it to 

store contact information. How can I change 
the folder type for this folder?

Q I’d like to add a sentence of text to a 
cell, but I can’t get it to format correct-

ly. How can I add text that I can format easily?

HELP DESKHELP DESKHELP DESK

A In PowerPoint, display a slide 
with an AutoShape on it. Right-

Word: Switch page number 
placement to meet your tastes

Excel: Format and wrap text 
in cells for an easy read

A The trick is to divide the document 
into separate document sections—

one for each different page numbering style 
you want. Then set the page number posi-
tion for each section.
• Insert sections. Click on the page 
where you want a new section to begin, 
then choose Insert | Break. In the Section 
Break Types panel, select a Page Type 
other than Continuous, such as Next 
page. In the same way, divide the rest of 
the document into sections as needed.
• Insert page numbers. You must do the 
sections in order, starting with the first 
one. Let’s assume that Section-1 has num-
bering where you want it, whether on 
the top or the bottom of the page. Choose 
View | Header And Footer. On the 
Header And Footer toolbar, click Show 
Next to go to Section 2, where you want to 
switch the page number position.

Use Switch Between Header and 
Footer as needed to switch to the loca-
tion of the existing page number and 
delete that number. Then switch back, 
set the insertion point where you do 
want the number, and click the Insert 
Page Number tool. Here’s the key step: 
at the top-right of the Header or Footer 
area is the label Same As Previous. Click 
the Header and Footer toolbar’s Same As 
Previous tool to turn that feature off. Do 
this for both the header and footer. If you 
want to make more changes, click Show 
Next, and move on to the next one. 

A As you’ve discovered, Excel doesn’t 
handle text as easily as a word pro-

cessing program does. For instance, if you 
add a line of text inside a cell and want to 
start a new paragraph, you can’t just press 
Enter. If you do, the insertion point moves 
to the next cell. This is Excel’s natural 
behavior, since it is designed to handle 
rows and columns of numbers.

If your text entry is longer than a few 
characters, and you want it to appear in 
a single cell, you can:
• Increase the cell’s row height and/or 
column width to fit the text. 
• Type the text, pressing [Alt+Enter] to 
start a new line within the cell.

Outlook: Create folders for 
better contact organization

click on the shape and choose Format 
AutoShape.

On the Color And Lines tab, you can set 
Fill and Line colors (including fill effects) 
and styles. If the shape is an arrow, you 
can change various arrow attributes here.

On the Size tab, you can set a specific 
size for the AutoShape, scale it, or rotate the 
AutoShape. On the Position tab, you can 
control where on the slide the AutoShape 
appears. If you need to set it at a specific 
position, instead of dragging it freehand, 
set the Horizontal and Vertical settings to 
the distance you desire from the Top Left 
Corner or from the Center of the slide, as 
shown in Figure A. After adjusting your 
settings, click OK.

Figure A

Q How do I set up page numbering so 
that some pages show their numbers 

at the top, while others show it at the bottom? 

Q I use several AutoShapes in my 
PowerPoint slides, but I can’t figure 

out how to format them. Can you help?

PPT: Format AutoShapes for 
more visual appeal

• Type the text, press Enter, click on the 
cell, and choose Format | Cells. Click on 
the Alignment tab and select the Wrap 
Text option and click OK.
• Use a text box: Display the Drawing 
toolbar by clicking the Standard tool-
bar’s Drawing tool. Then, click on the 
Text Box tool and draw a rectangular text 
box wherever you want the text. Type 
text in the text box just as you would in 
a word processor; press Enter at the end 
of a line. 

To format text in a cell, select the text 
in the Formula bar. Or, in a text box, 
select the text, right-click on it, and 
choose Format Text Box. Here you can 
set the font, font style, size, color, and 
various effects.

A Outlook does not allow you to 
change a folder’s type, but it 

sounds as though all you really need to 
do is to create a folder of the type you 
want.  

To do this, choose File | New | Folder. 
In the Name text box, type a folder 
name. Set the Folder Contains menu to 
the type of items to be stored there—one 
type per folder—this sets the folder type. 
For instance, to store Contacts, select 
Contact Items. Select a location for the 
new folder, such as under your current 
Contacts folder. Click OK.

To delete an unwanted folder, click on 
it in the Folder List and examine its con-
tents. Move any items in that folder that 
you want to save to another folder, then 
right-click on the previous folder, and 
choose Delete “[name of folder]”. Then, 
click Yes.
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Need to boost your confidence and productivity in other  
Microsoft applications? Try these titles to find out how.

FOR INFORMATION, CALL 1-800-424-8668
http://www.oootraining.com/ws/

q
q

q
q

q Microsoft Excel Microsoft Outlook
Microsoft Word Microsoft Office
Microsoft PowerPoint MS Excel for Advanced Users
 

TEST YOUR PC IQ

q

7

SUITE SUCCESS

Joan went overboard with her Outlook flags

Outlook: Become a View menu 
master

Outlook provides users with different ways to view email, Contacts, and 
the like. In this quiz, we test your knowledge of the View menu when 
you’re working with the Inbox. Can you associate the View menu com-
mands with their respective tasks?

Tasks
A. Displays a list of choices to view, e.g., Inbox, Calendar, Contacts
B. Displays a submenu of toolbar choices
C. Displays up to three lines of each message in your Inbox
D. Displays email message in bottom half of screen
E. Displays meeting reminders in a dialog box
F. Hides or displays your list of folders
G. Hides or displays the Outlook Bar
H. Hides or shows the status bar
I. Provides a submenu of several different views, such as Last Seven Days

View Menu Commands
____ 1. AutoPreview 
____ 2. Current View 
____ 3. Folder List 
____ 4. Reminders Window
____ 5. Outlook Bar 
____ 6. Go To
____ 7. Preview Pane 
____ 8. Status Bar 
____ 9. Toolbars 

Answers

Give Excel ranges 
an identity by 
naming them
Excel lets you select a range of one  

or more cells and give that range a 
descriptive name. Then you can type 
or paste the range name into a fomula 
instead of using hard-to-remember 
cell references. For example, if D6:
E9 has been named Sales, you can use 
=SUM(Sales), instead of =SUM(D6:E9). 

To name a range, select the cells and 
choose Insert | Name | Define. (Or, use 
the Collapse/Expand Dialog buttons to 
select the cells.) Type a name—without 
any spaces—and click Add. Define more 
names if desired. Click OK. 

If the selected data includes column 
and row labels, you can use them to 
name ranges: choose Insert | Name | 
Create, select the label location check 
boxes, e.g., Top Row, and click OK.

It’s easy to paste a range name while 
typing a formula. Choose Insert | Name 
| Paste, select the name, and click OK. 
For example, to add all values in the 
Qtr_1 and Qtr_2 ranges, type =SUM( 
and choose Insert | Name | Paste | 
Qtr_1 - OK, type a comma, then paste 
Qtr_2, and press Enter. 

To delete or change a range name, 
choose Insert | Name | Define. Select 
the unwanted name. To delete it, click 
Delete. Or, to change the selected name, 
type the new name in the top box and 
click Add, then select the old name, and 
click Delete and then OK. 

1-C  2-I  3-F  4-E  5-G  6-A  7-D  8-H  9-B 
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Insert an AutoShape
Let’s insert a star. Choose AutoShapes 
| Stars And Banners, and in the sec-
ond row, click the 16-Point Star. The 
mouse pointer changes to the Precision 
Select pointer (looks like a plus sign). 
Let’s put this star in the top-left corner 
of the document. Click at about the 
0" point on both the horizontal and 
vertical rulers, drag down and right to 
about the 3" point on each ruler, then 
release the mouse button.

Format an AutoShape
By default, your AutoShape has a 
thin black border but no fill color. To 
change these characteristics, right-
click on the shape and choose Format 
AutoShape. Then, click on the Color 
And Lines tab. Here we can add a fill 
color to the shape, as well as change 
the shape’s border. 

In the Fill panel, open the Color 
dropdown list. For this example, 
choose Dark Blue as the color to fill 
the shape. Click OK and see how your 
shape looks.

Add some transparency
One common way to use AutoShapes 
is to combine shapes to create a 
unique drawing object. For instance, 
you could stack one shape on top of 
another. To add a different touch to the 
coloring of the top shape, you can use 
the semi-transparent option.

Choose AutoShapes | Stars And 
Banners | 5-Point Star. Draw the new 
shape on top of the 16-point star—make 
it about an inch square. Drag it as 

needed to position it in the middle of the 
larger star. 

Right-click on the smaller star and 
choose Format AutoShape, then click 
on the Color And Lines tab. In the Fill 
panel, adjust the Transparency slider to 
about 80%.

Let’s give the star a border that 
contrasts well with the dark blue. In 
the Line panel, choose Yellow from the 
Color dropdown list.

Next, to make the line heavier,  
set the Weight spin box to 4.5 points. 
Also, open the Dashed dropdown list 
and select the fifth dash line, Long 
Dash, to give your five point star a 
dashed instead of a solid black outline. 

Click OK. The semitransparent top 
star lets just some of the bottom star’s 
dark blue show through.

Make them one
If you wanted to move your creation 
now, you would have to move each 
shape—the top star and the bottom 
star—separately. To join the shapes 
into a single object, you can group 
them. Click on the top shape, then 
[Shift+Click] on the bottom shape. Now, 
with both shapes selected, right-click on 
them and choose Grouping | Group. 

Now grab the unified shape and 
drag it to another location on your 
page. You’re ready to apply these tech-
niques to your own drawing shapes. 
You may close the document without 
saving. 

Word: Spice up your printed report with a customized 
AutoShape

Figure A

Word offers many pre-drawn shapes 
called AutoShapes. They include 

geometric shapes, arrows, starbursts, 
banners, and even flowchart elements.

In this tutorial, we look at the  
various types of AutoShapes, how to 
insert them in a document, and how 
to modify them. To follow along, open 
a blank document in Word, and make 
sure that you are in Print Layout view. 
Also, if necessary, display the Draw-
ing toolbar by clicking the Standard 
toolbar’s Drawing tool. 

Preview AutoShapes
To access AutoShapes, click the 
Drawing toolbar’s AutoShapes button. 
This displays a menu with submenus, 
including Lines, Block Arrows, and 
Flowchart, as shown in Figure A. Each 
submenu is a different AutoShape cat-
egory. They all offer individual shapes 
that you can add to your documents. 

With the AutoShapes menu open, 
choose Lines. You see a palette of six 
types of lines. In the same way, review 
the shapes offered on the next five sub-
menus.


